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Foreword 

Foreword 
 

 

Read this user’s guide before using this software. Keep it available at all 
times for future reference. If you need a replacement copy, contact your 
Ditch Witch® distributor. 

The descriptions and specifications in this guide are subject to change. 
Subsite® Electronics reserves the right to improve this product. Some product 
improvements may have taken place after this guide was published. For the 
latest information on Subsite Electronics products, see your Ditch Witch 
dealer.  

Thank you for buying Subsite Electronics equipment. 

 

User’s Guide 
TMS Plus 

Issue number 1.0/OP-05/15 
Part number 053-2833 

 

 

Copyright 2015 
by The Charles Machine Works, Inc. 

 

 

 

, , Subsite, and Ditch Witch are registered trademarks 
of The Charles Machine Works, Inc.  

This product is covered by U.S. patent 7000710.  
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Introduction 

Welcome 
The Trac Management System Plus (TMS Plus) is designed to help 
professional directional drilling operators be more productive.  

This software can be used to plan the bore before drilling in the first drill pipe. 
Variables such as topography, surface features, and existing underground 
utilities are easily included in the model. After defining the environment, the 
software applies engineering variables such as entry point, entry angle, 
depth, exit angle, and exit point. The software then graphically simulates a 
pipe-by-pipe plan for the bore. 

TMS Plus also integrates with Subsite Electronics’ directional drilling tracking 
system to allow you to record information about every drill pipe drilled. The 
system includes a full line of beacons, the 750/752 Tracker, and the 750/752 
Display or the 8500 Tracker and 8500 Display. 

Data such as depth, roll, pitch, beacon battery status, and beacon 
temperature displayed at the operator’s station on the 750/752 Display or 
8500 Display can be downloaded into the computer by pressing a button on 
the display. Estimated drill pipe data can be entered manually to fill in gaps 
where walkover tracking is not possible. As-drilled and as-installed maps of 
the bore can be printed on demand in color or black and white. The map can 
then be given to the facility owner for future reference. Bore information can 
also be downloaded from the 750/752 Display or 8500 Display directly into a 
job file to present either an as-drilled or as-installed report. 

Getting Help 
This user's guide provides a reference to the functions and commands of 
TMS Plus. 

Find a Help topic 

• Click the Contents tab to browse through topics by category. 

• Click the Index tab to see a list of index entries and then type the 
word you're looking for or scroll through the list. 

• Click the Find tab to search for words or phrases that may be 
contained in a Help topic. 

Print a Help topic 

• Click the Print button to print out the Help topic. 
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• Right-click and select Print Topic from the popup menu. 

 

System Requirements 
To use TMS Plus, we recommend the following: 

• PC, 512 MHz or faster, running Microsoft Windows 2000, XP, or 
Vista 

• 256 megabytes or more of RAM 

• CD-ROM drive 

• Pointing device (i.e. mouse or touchpad) 

• Enabled serial port 

If you do not have an enabled serial port, you will need one of the 
following: 

• Serial I/O PC card and serial port adapter (preferred) 

• USB serial port adapter 

Equipment Compatibility 
TMS Plus will work with the any of the following Subsite Electronics products: 

• Subsite 66TKRW/90D 

• Subsite 750/752 Tracker and Display 

• Subsite 8500 Tracker and Display 

Personnel Qualifications 
To use TMS Plus, you should be familiar with personal computers. Someone 
familiar with personal computers should be able to: 

• Send email. 

• Use Microsoft Word to write a letter. 

• Use Internet Explorer or another web browser. 
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Getting Started 

Registering your TMS Plus Software 
We encourage you to register your TMS Plus software as soon as you've 
installed it onto your system. By registering your software, you are entitled to 
the following services: 

• Product support 

• Advance notification of new product updates 

Understanding TMS Plus 
Getting started on TMS Plus is as easy as creating or opening a word 
processing file and entering information. To get the most out of your TMS 
Plus experience, it is important to know the program and its components. 

Control Panel 

When TMS Plus is activated, the Control Panel will appear. It is the main 
hub from which all other components extend like wheel spokes, providing 
one place to access all program components. 

Use Settings to set your preferences for language, font, date and time 
display, and units of measurement. 

Click on Download to activate the Download Wizard, a step-by-step 
procedure for downloading jobs from your 750/752 Display or 8500 Display 
into TMS Plus. 

In Plan, you can access the Job Panel, the main work area of TMS Plus. 

For help, click on User's Manual to access the TMS Plus User's Guide. 

End your TMS Plus work session by clicking on Exit. 

Layers 

In TMS Plus, you enter specific job information into a specific layer. For 
example, enter topography information into the Topography layer. Each 
layer builds onto the previous layer, forming a complete planned path, pilot 
bore path, or as-installed map and report. The layers are organized in the 
Layer Manager and displayed on the Planning Grid. 
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Job Panel 

The Layer Manager and Planning Grid are the main components of the 
Job Panel. They work together in planning and mapping job information. The 
Layer Manager, located on the left-hand side of the screen, displays the 
name, type, connection, and visibility status of each layer.  

You can connect a 750/752 Display or 8500 Display to either a Pilot Bore or 
Backream layer to receive real-time pipe information directly. You can also 
select which layers to hide or show for display on the Planning Grid. The 
Planning Grid, located on the right-hand side of the screen, displays the 
bore map. 

The Job Panel has six menus available to perform various program 
functions like adding a layer to a job or zooming in on a portion of the map. 
To perform commands, click on the needed menu and then click on the 
command or use the keyboard shortcut. 

File Menu 
Command Description Shortcut 

New Begins a new job Press Ctrl+N 

Open Opens a new job with a different file 
name 

Press Ctrl+O 

Save Saves all changes to the job file Press Ctrl+S 

Save As Saves the job file with a different 
file name 

Press Alt+S 

Export Saves the job file into a CAD 
drawing or image (JPEG or PNG) 
file format 

Press Ctrl+E 

Page Setup Specifies the page size and 
orientation for printing 

Press Ctrl+G 

Print Prints the job file to a connected 
printer 

Press Ctrl+P 

Exit Exits from TMS Plus Press Ctrl+X 
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Edit Menu 
Command Description Shortcut 

Undo Removes the last entry or function 
entered into job file 

Press Ctrl+Z 

Add Item Adds a point to the selected layer 
on the Planning Grid. Point is 
determined by the away, lateral, 
elevation and depth measurements  

Press the Insert 
key 

Delete Item Removes a specific point from the 
Planning Grid and Layer 
Properties 

Press the Delete 
key 

Edit Item Edits item properties Press the F3 key 

Next Item Moves to the item right of the 
currently selected item 

Press the Right 
Arrow key 

Previous 
Item 

Moves to the item left of the 
currently selected item 

Press the Left 
Arrow key 

Job 
Properties 

Opens the Job Properties menu 
where the optional job name can be 
edited 

Press the F2 key 

Grid 
Properties 

Opens the Grid Properties menu 
where the grid volume can be 
adjusted 

Press Ctrl+F2 

Units Changes the measurement units Press Ctrl+U 

 

Layer Menu 
Command Description Shortcut 

Add Layer Adds a new layer to the job file Press 
Ctrl+Insert 

Delete Layer Removes a layer and all items in 
that layer from the job file 

Press Ctrl+Del 

Edit Layer Edits layer properties Press Ctrl+F3 

View Layer Displays layer report for the 
selected layer 

Press 
Ctrl+Space 

Next Layer Moves to next layer in the Layer 
Manager 

Press the Down 
arrow key 
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Previous 
Layer 

Moves to the previous layer in the 
Layer Manager 

Press the Up 
arrow key 

Import Layer Imports data from an external 
source (such as a download file) 
into a layer 

Press the F4 
key 

Export Layer Exports data from a layer into either 
a DXF or CSV file format for use in 
an external application 

Press Ctrl+F4 

 

Wizards Menu 
Command Description Shortcut 

Bore 
Planning 

Invoke either the Critical-Point 
Bore or Grade Bore wizard 

Press Ctrl+B 

Entry 
Reversing 

Invoke the Entry Reversing wizard 
to swap Entry and Exit points 

Press Ctrl+R 

 

View Menu 
Command Description Shortcut 

Zoom In Enlarges item size on Planning 
Grid 

Press the F5 key 

Zoom Out Reduces item size on Planning 
Grid 

Press the F6 key 

Zoom Layer Displays entire selected layer on 
Planning Grid. 

Press the F7 key 

Fit Width Fits all layers within the Planning 
Grid 

Press Alt+F7 

Go To … Centers specific area on Planning 
Grid. 

Press the F8 key 

Grid  Displays or hides the grid lines in 
Planning Grid. 

Press the F9 key 

 

Help Menu 
Command Description Shortcut 

User's 
Manual 

Opens the TMS Plus User's 

Manual. 
Press the F1 key 

About Displays the software version of 
TMS Plus. 

Press Ctrl+F1 
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Exiting TMS Plus 
When exiting TMS Plus, you will be prompted to save changes before closing 
the file. 

 

Product Support 
Call 1-800-846-2713 for TMS Plus support. Outside of the U.S., call 0+11+ 
580-572-3700. 
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Setting Preferences 

Language 
Use the Language menu to select between German, French, Spanish, 
Italian, Russian, Simplified-Chinese, and English languages. 

Change language 

1. From the Control Panel, click Settings. 

2. Click the Language box arrow and select language. 

3. Click OK. 

Font 
Use the Font menu to change the font or appearance of text in the program.  

Change font 

1. From the Control Panel, click Settings. 

2. Click the Change button. 

3. In the Font list, select a new font. 

4. In the Font Style list, select a new font style. 

5. In the Size list, select a new font size. 

6. In the Effects area, click Strikeout or Underline if necessary. 

7. Click OK. 

Unit of Measurement 
Use the Units menu to select between English or Metric units. You can also 
select the number of decimal places to display. 

Change the unit of measurement 

1. From the Control Panel, click Settings. 

2. On the Settings menu, click the Units tab. 

3. In the Length Unit box, click Metric or US Feet. 
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4. In the Precision box, type or select the number of decimal points 
to display. Click the arrows to see options. 

5. Click OK. 

Date/time Format 
Use the Date/Time menu to select the way the date and time appear on 
printed job sheets. 

Change the date/time format 

1. From the Control Panel, click Settings. 

2. On the Settings menu, click the Date/Time tab. 

3. Under Date Format, select the appearance of the day, month, 
and year. 

4. Under Time Format, select the appearance of the hours, 
minutes, and seconds. 

5. Click OK. 
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Plan Bore 

Preparation 
A successful job begins before the bore. The first step in planning is 
reviewing information already available about the job and jobsite. 

Job Plan 

Review blueprints or other plans and make sure you have taken bore 
enlargement during backreaming and pullback into account. Check 
for information about existing or planned structures, elevations, or 
proposed work that may be taking place at the same time. 

One-Call Services 

Call area One-Call or similar services and have existing lines located 
and marked. Call any utilities in your area that do not subscribe to 
One-Call. 

Pullback Material 

Ask for a sample of the material you will be pulling back. Check its 
weight and stiffness. Contact the manufacturer for bend radius 
information. Check that you have appropriate pullback devices. 

Traffic Control 

If working near a road or other traffic area, contact local authorities 
about safety procedures and regulations. 

Inspect Site 
Inspect jobsite before planning bore. Check for the following: 

• Overall grade or slope 

• Changes in elevation such as hills or open trenches 

• Obstacles such as buildings, railroad crossings, or streams 

• Signs of utilities  

• Traffic 

• Access 

• Soil type and condition 

• Water supply 

• Sources of locator interference (rebar, railroad tracks, etc.) 
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Take soil samples from several locations along bore path to determine best 
bit and backreamer combinations. 

Identify Hazards 
Identify safety hazards and classify jobsite.  

Jobsite hazards could cause death or serious injury. Use correct equipment 
and work methods. Use and maintain proper safety equipment. 

NOTICES: 

• Notify One-Call and companies which do not subscribe to One-
Call. 

• Verify location of previously marked underground hazards. 

Remember, jobsite is classified by hazards in place -- not by line being 
installed. 

Select Start and End Points 
Select one end to use as a starting point. Consider the following when 
selecting a starting point: 

Slope  

Fluid system should be parked on a level site. Consider how slope 
will affect drilling unit set-up, bending pipe, and fluid flow out of hole. 

Traffic 

Vehicle and pedestrian traffic must be a safe distance from drilling 
equipment. Allow at least 10 ft (3 m) buffer zone around equipment. 

Space 

Check that starting and ending points allow enough space for 
gradual pipe bending.  
Check that there is enough space to work and to set up Electric 
Strike System. 

Comfort 

Consider shade, wind, fumes, and other site features. 
Drill downhill when possible so fluid will flow beyond the drilling unit. 

 

Plan Process 
You must plan the bore path from entry to end before drilling begins. Bore 
information, such as entry point, entry angle, minimum bend radius, 
maximum depth, and exit point, is used to create a TMS Plus bore plan and 
map. 

In creating this plan, enter the topography, surface features, and obstacles to 
provide a true representation of the job site. Then enter the entry point, exit 
point, and maximum depth to create a proposed pilot bore path. 
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NOTICE: Follow all safety precautions listed in the drilling unit operator's 
manual. 

IMPORTANT: TMS Plus cannot predict changes in bore path caused by 
sudden changes in soil conditions, improper drill head steering, incorrect drill 
pipe data, or missing drill pipe data. Subsite Electronics assumes no 
responsibility for improperly entered variables. Always verify entered data. 

Create a new job 

1. From the Control Panel, click Plan, and then select New File. 

2. In the File Name box, enter a filename. 

3. Click OK. 

4. In the Job Name box, enter a job or location name. 

5. Click OK. 

Open an existing job 

1. From the Control Panel, click Plan, and then select Existing 
File. 

2. In the Open menu, select file. 

3. Click OK. 

Add Topography Information 

Use the Topography layer to enter changes in surface elevation caused by 
ditches, hills, rivers and ponds.  These all provide valuable reference points 
when the program plans the bore. 

Add topography 

1. Create new job or open an existing one. 

2. In the Layer Manager, double click on Topography to open the 
Survey Properties menu. 

3. In the Layer Name box, type in a new layer name, then click OK. 

4. Click on the Draw tool, then click on the Planning Grid to add 
first point. 

5. In the Properties menu: 

• Click in Away, then type in the away measurement. 

• Click in Lateral, then type in the lateral measurement. 

• Click in Elevation, then type in the elevation measurement. 

6. Click OK. 

7. Repeat steps 4 – 6 to add next point. 

Add Features 

Use the Line or Image layer to create the surface features of the job plan.  
Surface features include roads, rivers, lakes, trees, buildings or anything that 
is above ground that is near the planned bore or backream path. 
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Add a line layer 

1. Click on the Add Layer icon. 

2. Select Line from the New Layer menu. 

3. In the Layer Properties menu, type in a layer name. 

4. Click the Feature Properties tab. 

5. Click in the Line Width box, type in a line width from 1 (thinnest) 
to 10 (thickest), then press Enter. 

6. Click Edit Color button to change line color, select the new line 
color, then click OK. 

7. Click OK. 

8. Click on the Draw tool, then click on the Planning Grid to add 
first point. 

9. In the Properties menu: 

• Click in Away, then type in the away measurement. 

• Click in Lateral, then type in the lateral measurement. 

• Click in Elevation, then type in the elevation measurement. 

10. Click OK. 

11. Repeat steps 8 – 10 to add next point. 

Add an image layer 

1. Click on the Add Layer icon. 

2. Select Image from the New Layer menu. 

3. In the Image Properties menu, type in a layer name, then click 
OK. 

4. Click on the Draw tool, then click on the Planning Grid to add 
point. 

5. In the Properties menu, under the Position tab: 

• Click in Away, then type in the away measurement. 

• Click in Lateral, then type in the lateral measurement. 

• Click in Elevation, then type in the elevation measurement. 

6. Click the Image tab. 

7. Click the Open File button, select file, and then click OK. 

8. Click Preview tab to view image. 

9. Click OK. 

10. If necessary, click on the Move tool, then click and hold the 
image anchor and drag to the appropriate location. 

Add Obstacle Information 

Use one of the Obstacle layers to enter information for any underground 
communications, electric, gas, sewer, or water obstacle. 
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Add obstacle 

1. Click on the Add Layer icon. 

2. Select the type of obstacle layer to create from the New Layer 
menu. 

3. In the Obstacle Properties menu, type in a layer name. 

4. Click in Diameter, then type in the obstacle diameter. 

5. Click in Minimum Clearance Zone, then type in the minimum 
clearance zone. 

6. Click OK. 

7. Click on the Draw tool, then click on the Planning Grid to add 
first point. 

8. In the Properties menu: 

• Click in Away, then type in the away measurement. 

• Click in Lateral, then type in the lateral measurement. 

• Click in Depth, then type in the depth measurement. 

9. Click OK. 

Label Map 

Use a Text layer to label the map or to add your notes to the job plan. 

Add text 

1. Click on the Add Layer icon. 

2. Select Text from the New Layer menu. 

3. In the Text Properties menu, type in a layer name, then click 
OK. 

4. Click on the Draw tool, then click on the Planning Grid to add 
point. 

5. In the Properties menu, under the Position tab: 

• Click in Away, then type in the away measurement. 

• Click in Lateral, then type in the lateral measurement. 

• Click in Elevation, then type in the elevation measurement. 

6. Click on Notes tab. 

7. Type text into the box. 

8. Click the Change Font button to change the font style. If no 
changes are needed, click OK. 

9. Click the Change Color button to change font color. If no 
changes are needed, click OK. 

10. Click the Preview tab to view text. 

11. Click OK. 
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12. If necessary, click on the Move tool, then click and hold the text 
anchor and drag to the appropriate location. 

Enter Plan Information 

Use the Plan layer to enter the entry point, exit point and maximum bore 
depth. These three items, along with the topography, features, and 
obstacles, create a sequence of target points that the drill string must go 
through. 

After placing the target points, the proposed pilot bore or backream path is 
mapped using the minimum pipe or product bend radius and length 
information.  

IMPORTANT: If red appears in any portion of the planned path, this 
indicates that the bend radius has been exceeded.  Adjust the entry point, 
exit point or depth to remove the red. 

You have two options for bore planning: use the Bore Planning Wizard or 
enter the plan parameters yourself. The easiest and fastest way to plan 
bores is to use the Bore Planning Wizard, especially when planning a grade 
bore.  

You can modify plan parameters to avoid obstacles by adding or removing 
target points and by editing the target point properties. 

Start Bore Planning Wizard 

1. Click on the Wizards menu. 

2. Select Bore Planning. 

3. When the Bore Planning Wizard appears, click on either the 
Critical-Point Bore tab (to plan based on a desired depth at one 
critical point) or the Grade Bore tab (to plan a grade bore). 

4. Follow wizard directions to plan the bore. 

Enter plan parameters 

1. In the Layer Manager, double-click on Plan to open the Plan 
Properties menu. 

2. In the Layer Name box, type in a new layer name, then click OK. 

3. Click on the Draw tool, then click on the Planning Grid to add 
entry point. 

4. In the Properties menu: 

• Click in Away, then type in the away measurement. 

• Click in Lateral, then type in the lateral measurement. 

• Click in Depth, then type in the depth measurement. 

• Click in Pitch, then type in the pitch measurement. 

• Click in Yaw, then type in the yaw measurement. 

5. Click OK. 

6. Repeat above steps to add a maximum depth point and an exit 
point. 
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7. Draw proposed bore path: 

• Click on Add Layer icon. 

• Select either Pilot Bore or Backream from the New Layer 
menu. 

• In the Layer Properties menu, type in a layer name. 

8. If necessary, enter length, diameter and bend radius of pipe or 
product. 

9. If red appears in any portion of the proposed path, return to the 
Plan layer to adjust the entry point, exit point or depth until red is 
removed. 

Create pilot bore layer 

1. Click on the Add Layer icon. 

2. Select Pilot Bore from the New Layer menu. 

3. Under Layer Name in the Bore Properties menu, type in a layer 
name. 

4. Click in Pipe Length, then type in the pipe length. 

5. Click in Diameter, then type in the pilot bore diameter. 

6. Click in Minimum Bend Radius, then type in the minimum bend 
radius. 

7. In Attributes, select the properties to display in the layer report. 

Create backream layer 

1. Click on the Add Layer icon. 

2. Select Backream from the New Layer menu. 

3. Under Layer Name in the Backream Properties menu, type in a 
layer name. 

4. Click in Pipe Length, then type in the pipe length. 

5. Click in Diameter, then type in the backream path diameter. 

6. Click in Minimum Bend Radius, then type in the minimum bend 
radius. 

7. In Attributes, select the properties to display in the layer report. 

Print 

1. From the File menu, select Print. 

2. Select item to print. 

3. Click printer icon to print. 

Modify plan parameters 

Add target point 

1. Select Plan from the Layer Manager. 
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2. Click on the Draw tool, then click on the Planning Grid to add 
new target point. 

3. In the Properties menu: 

• Click in Away, then type in the away measurement. 

• Click in Lateral, then type in the lateral measurement. 

• Click in Depth, then type in the depth measurement. 

• Click in Pitch, then type in the pitch measurement. 

• Click in Yaw, then type in the yaw measurement. 

4. Click OK. 

Remove target point 

1. Select Plan from the Layer Manager. 

2. Click on the Erase icon. 

3. Click on the point to delete in the Planning Grid. 

4. Click Yes. 

Modify target point 

1. Select Plan from the Layer Manager. 

2. Click on the point to modify. 

3. Modify target point properties. 
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Record Bore 

Plot Pipes 
When TMS Plus is connected to a 750/752 Display or 8500 Display, pipes 
can be plotted onto the Planning Grid.  When not connected, stored jobs 
can be downloaded into TMS Plus from the display and then downloaded 
into a layer to create a pipe-by-pipe map. 

IMPORTANT: If you have not planned the bore using TMS Plus, you must 
first enter an entry point into the pilot bore or an exit point into the backream 
layer.   

Plot pipes while connected 

IMPORTANT: If you have not planned the bore using TMS Plus, you 
must first enter an entry point into the pilot bore or an exit point 
into the backream layer.   

1. Press On/Off button on display to shut down the display. 

2. Plug display cable into the download connection port located on 
or near the drilling unit's operator station. 

3. Plug display cable into serial port (750/752 Display) or USB port 
(8500 Display) of your computer. 

4. From the Layer Manager, double-click on the layer to add pipes 
into or add a layer. 

5. Select the icon that matches the Display (90D, 750/752 or 8500). 

6. Select the Serial Port # (for 90D or 750/752) or virtual Serial 
Port (for 8500) that the display is connected or virtually mapped 
to. For virtual USB Serial Ports, use Windows Device Manager to 
discover COM and LPT Ports.  

7. Click Connected in Bore Properties menu. 

8. Click OK. 

9. Press On/Off button on display to turn power on to the display. 

10. When the Initialized message appears on your monitor, click 
OK. 

11. For 90D and 750/752 Displays: Press and release Store to plot 
pipe on Planning Grid.  
For 8500 Displays: Use the on-screen menu and buttons to store 
pipes on Planning Grid. 
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NOTE:  If the depth measurement is incorrect or not taken from 
directly above the beacon (i.e. locating over a creek), then 
deselect Walkover Mode from Properties menu. 

Plot stored pipes 

1. Open the Download Wizard: 

From the Control Panel, select Download.  Follow the 
instructions to download stored pipes. 
NOTE: To create a *.750 compatible file from an 8500 
Display, follow the 8500 Display on-screen instructions. 

2. Create a new job or open an existing one. 

3. From the Layer Manager, click on the layer to add pipes into or 
add a layer. 

4. Click the Import button. 

5. Select the previously downloaded .750 Display file created by 
the Download Wizard. 

6. Click OK. 
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Reporting  

View Reports 
Each TMS Plus job is made up of a map and a report. When you create a 
layer, a report file is automatically generated containing the layer attributes. 
These measurements are displayed in the report. Reports can be printed out 
or saved as an HTML file.   

There are seven reports to choose from: 

Topography 

Report attributes include the Away, Lateral, and Elevation 
measurements. 

Plan 

Report attributes include the Away, Lateral, Elevation, Depth, Pitch, 
and Yaw measurements. 

Bore  

Report attributes are determined by selecting properties found in the 
Bore Properties menu. 

Backream 

Report attributes are determined by selecting properties found in the 
Bore Properties menu. 

Pipe Number 

Report attributes include Away, Lateral, Depth, Pitch and Deflection 
measurements. 

Obstacles 

Report attributes include Diameter, Minimum Clearance Zone, Away, 
Lateral, Depth, and Elevation measurements. 

Features 

Report attributes include Away, Lateral, and Elevation 
measurements, the File Name or Caption. 

View a report 

1. From the Layer Manager, select the layer to view. 

2. Press Ctrl + Space. 

3. Click the Done button to close report. 
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Print a report 

1. From the Layer Manager, select the layer to print. 

2. Press Ctrl+Space. 

3. Click the Print button. 

4. In the Print menu, choose a printer and click Print or OK. 

5. Click the Done button to close report. 

Save report as an HTML file 

1. From the Layer Manager, select the layer to save. 

2. Press Ctrl+Space. 

3. Click the Save (Disc) button. 

4. In the Save As menu, select the directory to save file to and 
enter a filename. 

5. Click Save or OK. 

6. Click the Done button to close report. 
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How Do I… 

How Do I… 

• Plan a grade bore? 

• Draw and print an as-drilled map? 

• Draw and print an as-installed map? 

• Remove items and layers from the job file? 

• Add a pipe to a plotted map? 

• Move a previously stored point to the correct place? 

• Map my bore once it is started? 

• Change my measurement units? 

• Change the Planning Grid size? 

• Put my logo on the map? 

• Bring my TMS 2.1 pilot bore information into a TMS Plus file? 

• Use a TMS Plus file in another planning package? 

Plan a grade bore? 

Use the Grade Bore Planning Wizard. 

Draw and print an as-drilled map? 

1. Create a new job or open an existing one. 

2. Add Topography layer. 

3. Add a Features layer as necessary. 

4. Add an Obstacle layer as necessary. 

5. Add a Pilot Bore layer. 

6. Plot pipes or plot stored pipes. 

7. Print map. 

Draw and print an as-installed map? 

1. Create a new job or open an existing one. 

2. Add Topography layer. 

3. Add a Features layer as necessary. 
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4. Add an Obstacle layer as necessary. 

5. Add a Backream layer. 

6. Plot pipes or plot stored pipes. 

7. Print map. 

Remove items and layers from the job file? 

Remove items 

1. Click on the Erase icon. 

2. Click on the point to delete in the Planning Grid. 

3. Click Yes. 

Remove layers 

1. Click on the layer to delete in the Layer Manager. 

2. Click on the Delete Layer icon. 

3. Click Yes. 

Add a pipe to a plotted map? 

1. Select the Bore or Backream layer to add pipe into. 

2. Press the Insert key. 

3. In the Pipe Number Properties menu, select Walkover Locate. 

4. Click in Depth and type in depth measurement. 

5. Click in Pitch and type in pitch measurement. 

6. Click in Yaw and type in yaw measurement. 

7. Click in Pipe Length and type in pipe length measurement. 

8. Click OK.  

Move a previously stored point to the correct place? 

1. Select the point to be removed. 

2. In the Properties menu, select Manual Locate. 

3. Click in Away and type in away measurement. 

4. Click in Lateral and type in lateral measurement. 

5. Click OK. 

Map my bore once it is started? 

1. Create a new job or open an existing one. 

2. Add Topography layer. 

3. Add a Pilot Bore layer. 

4. Add point. 
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Change my measurement units? 

1. From the Edit menu, select Units. 

2. Click on Length Units arrow and select either Metric or US 
Feet. 

3. Click on Precision arrows to select number of decimal places to 
display. 

4. Click OK. 

Change the Planning Grid size? 

1. From the Edit menu, select Grid Properties. 

2. Click in Grid Size, then select new size. 

3. Click OK. 

Put my logo on the map? 

1. Click on the Add Layer icon. 

2. Select Image from the New Layer menu. 

3. In the Layer Properties menu, type in a layer name, then click 
OK. 

4. Click on the Draw tool, then click on the Planning Grid to add 
point. 

5. In the Properties menu: 

• Click in Away, type in the away measurement, then press 
Enter. 

• Click in Lateral, type in the lateral measurement, then press 
Enter. 

• Click in Elevation, type in the elevation measurement, then 
press Enter. 

6. Click the Image tab. 

7. Click the Open File button, select file, and then click OK. 

8. Click Preview tab to view image. 

9. Click OK. 

10. If necessary, click on the Move tool, then click and hold the 
image anchor and drag to the appropriate location. 

Use a TMS Plus file in another planning package? 

Pilot bore layers and/or backream layers created in TMS Plus can be 
exported into different file formats for use with other planning systems. An 
AutoCad (.dxf) file or a comma separated variable (.csv) file for use with GIS 
packages or Microsoft Excel can be created from a TMS Plus job plan. 
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Export a job plan 

1. Click Export button. 

2. Enter a new file name in the File Name box. 

3. Select either .dxf or .csv from Save As File Type box. 

4. Click OK. 



Subsite® Electronics TMS Plus Glossary of Terms •••• 29 

Glossary of Terms 

Glossary of Terms 
Away 
The measured distance along the reference line. 

Depth 
The vertical distance from the surface to the transmitter 

Drill string 
The combined assembly of components including, but not limited to, drill 
pipe, tool head, and/or beacon housing connected to the drilling unit. 

Elevation 
The vertical dimension above/below sea level. 

Entry angle 
The angle between the drill pipe and the ground with the machine in the 
operating or working position. 

Entry point 
Also called punch-in, zero, or base point, this represents the point the drill 
string enters the ground. It is the zero point for all other measurements. 

Exit angle 
Angle between the drill pipe and the ground at the exit point. 

Exit point 
The point at which the drill pipe exits the ground or enters the exit pit. 

Features 
Above-ground objects that are points of interest, i.e. highways, railroads, 
rivers, buildings, etc. 

Grade 
Inclination measurements expressed in either degrees or percent. 

Lateral 
The measured distance perpendicular to the reference line. 

Manual locate 
The process of identifying a known beacon position in TMS Plus based on 
away and lateral measurements. 

Minimal bend radius 
The calculated bend limit of the specified drill string or installed product 
during the drilling operation. 

Obstacles 
Underground such as existing pipes, concrete pillars, boulders, or cable. 
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Pilot bore path 
The centerline location of the pilot bore. 

Pitch 
The measured inclination of the transmitter. 

Target points 
Defined points along the planned path. 

Topography 
The configuration of the ground surface including changes in elevation and 
the position of natural and man-made features. 

Walkover mode 
The process of taking a depth and pitch measurement from a known 
elevation while standing directly over the beacon. 

Yaw 
The right or left angle away from the reference line. 


